
 Exam Information  

 

  

 ETRA SKILLS COMPETENCY EXAM > CONTROL PANEL > EXAM INFORMATION

  Item   Folder   External Link  Course Link  Test  Select:   Learning Unit

   EXAM OVERVIEW 

 
This three hour exam is made up of the following areas:  

 
Exam Part 1: Basic computing concepts  
Exam Part 2: Word processing  
Exam Part 3: Microsoft PowerPoint  
Exam Part 4: Microsoft Excel  
Exam Part 5: Internet and web development skills  
 
Please work at your own pace. All programs necessary to 
complete this exam are loaded onto the computer you are 
using. You may use any programs/applications on the computer 
or Internet during the exam.  
 
EXAM SCORING  
The online multiple choice test sections of the exam will be 
automatically graded after you submit the section. Your score 
will then be immediately displayed to you. The Hands-on 
application sections should be submitted on the floppy disk 
given to you; they will be scored following the exam. Scores will 
be mailed to you in one to two weeks after the test. To pass the 
exam, you must receive at least a 70% on each total section of 
the exam and a 70% overall.  
 
Please note: You will only be permitted to take a section of this 
exam one time. Once you submit a multiple choice section of 
the test, it will no longer be available to you. When you are 
ready to submit the multiple choice sections of the exam, click 
the "Submit" button; do not click the "Save" button.  
 
GETTING STARTED  
1. Click on the "Competency Exam" action button at the left of 
this screen.  
2. Click on the "Exam Part" that you would like to take first.  
3. Click the section of the "Exam Part" that you would like to 
complete.  
4. Follow all instructions provided within the section.  
After you have submitted a section of the exam, you may 
navigate to other sections by first clicking on the " Competency 
Exam" button on the left side of the screen, then selecting the 
exam section you wish to complete.  
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 Competency Exam  

 

  

 ETRA SKILLS COMPETENCY EXAM > CONTROL PANEL > COMPETENCY EXAM

  Item   Folder   External Link  Course Link  Test  Select:   Learning Unit

   Exam Part 1. Basic Computing Concepts 1
Modify Manage  Copy Remove

   Exam Part 2. Word Processing 2
Modify Manage  Copy Remove

   Exam Part 3. Microsoft PowerPoint 3
Modify Manage  Copy Remove

   Exam Part 4. Microsoft Excel 4
Modify Manage  Copy Remove

   Exam Part 5. Internet and Web Development 
Skills 
5 Modify Manage  Copy Remove
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Preview Assessment: Basic Computing Concepts 

 ETRA SKILLS COMPETENCY EXAM > CONTROL PANEL > COMPETENCY EXAM > EXAM PART 1. BASIC COMPUTING CONCEPTS > PREVIEW 
ASSESSMENT: BASIC COMPUTING CONCEPTS

Name Basic Computing Concepts 

Instructions Please select the option(s) that best answer the questions. If a question contains more than 
one correct answer, select all of the answers that apply. When finished use the "Submit" 
button. Do not select "Save." 

Multiple Attempts Not allowed. This Test can only be taken once. 

Force Completion This Test must be completed now. 

 Question Completion Status: 

   Question 1 1 points   Save

 

Which of the following are input devices? 
 

URL 

Monitor 

Hard Drive 

Keyboard 

Printer 

   Question 2 1 points   Save

 

An example of an operating system is 
 

 The World Wide Web 

 Microsoft Office 

 Windows XP 

 America Online 

   Question 3 1 points   Save

 

The CPU can be likened to the "brain" of the computing system. 
 

 True

 False

   Question 4 4 points   Save

 

Match the Storage Device to its approximate storage size. 
 

 - Floppy Disk  

 - Hard Disk  

 - CD-Rom  

Zip Disk  

 
A. 100-250 MB 
B. 1-2 MB 
C. 20 GB 
D. 650 MB 

Page 1 of 3Preview Assessment: Basic Computing Concepts

6/30/2008https://webcourses.niu.edu/webapps/assessment/take/launch.jsp?course_assessment_id=_5...



 -

   Question 5 1 points   Save

 

Text or objects that are cut or copied are stored on the 
 

 Blackboard 

 Clipboard 

 White Board 

 Bulletin Board 

   Question 6 1 points   Save

 

The keyboard shortcut to saving a file is 
 

 CTRL + O 

 ALT + O 

 CTRL + S 

 ALT + S 

   Question 7 1 points   Save

 

To get a simple explanation of a toolbar button 
 

 click the button 

 right click the button 

 move your cursor over the button and wait a second

 select Buttons from the help menu 

   Question 8 1 points   Save

 

A computer system's memory is 
 

RAM 

BIOS 

CD-ROM 

SCRAM 

   Question 9 1 points   Save

 

To select multiple files hold down the _______ key(s). 
 

 Alt 

 F12 

 Shift 

Function 
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   Question 10 1 points   Save

 

The __________ view in the Open Files dialog box displays the file size, type and 
date. 
 

 List 

 Details 

 SetUp 

 Preview 
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Preview Assessment: Word Processing Concepts 

 ETRA SKILLS COMPETENCY EXAM > CONTROL PANEL > COMPETENCY EXAM > EXAM PART 2. WORD PROCESSING > PREVIEW ASSESSMENT: 
WORD PROCESSING CONCEPTS

Name Word Processing Concepts 

Instructions Please select the option(s) that best answer the questions. If a question contains more than 
one correct answer, select all of the answers that apply. When finished use the "Submit" 
button. Do not select "Save." 

Multiple Attempts Not allowed. This Test can only be taken once. 

Force Completion This Test must be completed now. 

 Question Completion Status: 

   Question 1 1 points   Save

 

If you want to change your paper size from letter to legal size, which of the following 
would you use? 
 

 Page Set-up 

 Print Layout 

 Styles and Formatting 

 Templates and Add-ins

   Question 2 1 points   Save

 

Which of the following options are not available when checking for misspellings in a 
document? 
 

 Ignore All 

 Add 

 AutoCorrect 

 Replace 

   Question 3 1 points   Save

 

Which formatting feature would allow you to select the color of the text in your 
document? 
 

 Background 

 Bullets and Numbering 

 Columns 

 Font 

   Question 4 1 points   Save

Which of the following format options would you use to change the case of "chicago, 
illinois" to appear appropriately as "Chicago, Illinois". 
 

Sentence Case 
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 Upper Case 

 Toggle Case 

 Title Case 

   Question 5 1 points   Save

 

Field Trip Budget 

What sequence was used to format the budget that is shown above? 

Buses $ 145.00

Children's Admission Fees 367.00

Chaperone Admission Fees 36.00

 

 Left tab followed by a decimal tab

 Right tab followed by a space bar

 Left tab followed by a center tab 

 Space bar 
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 Application Section  

 

 ETRA SKILLS COMPETENCY EXAM > CONTROL PANEL > COMPETENCY EXAM > EXAM PART 2. WORD PROCESSING > APPLICATION SECTION

  Item   Folder   External Link  Course Link  Test  Select:   Learning Unit

   Application Overview 
 
The role of a teacher in today's elementary and secondary 
schools demands (among many things) that you correspond 
with many members of your school community – students, 
parents, others. 
 
In this application you will write a form letter (main document) 
for use in a mail merge. Create a database table (data source) 
and produce the merged documents. Follow all four steps to 
complete the application. 

You may complete this application manually, or by using Word's 
Mail Merge Wizard. 

1 Modify  Manage  Copy Remove

   Step 1: Creating the Form Letter (main document) 
Immediately following the directions and specifications is the 
text for the form letter. You may copy and paste into a new 
Word document. This will save you from rekeying the letter. 
 
Use these specifications for creating the form letter and saving 
it for submission. 

1. Set page margins to 1" on all sides. 
 

2. Set header and footer to 0.6" from edge. 
 

3. Use the Times New Roman font, regular, size 12. 
 

4. Set paragraph spacing to 1.5 line spacing. 
 

5. Use today's date and have it automatically update. 
 

6. Create a header for the document. Use your school's 
name for the header. Use Arial and size 16 and bold for 
the title. Center the text. 
 

7. Put the list of the three teams in a centered table that 
contains two rows, and three columns. Column widths 
should be equal and closely wrapped about the text.  
 

8. Put the team names in the upper cells. Boldface the 
team names. Put the names of team members in the row 
cell directly below appropriate team name.  
 

9. Save the document to your disk as 
team_announce_z#.doc. The z# in the name refers to 
your full z-number. This is required so that your 
application materials are easily identifiable. E.g. 
team_announce_z200001.doc  
 

 

2
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October 16, 2003 
 
[Parent] 
[Address] 
[City], [State] [Zip] 
 
Dear [Parent], 
 
Our class will be competing in its seventh annual science fair 
this fall. As you may or may not be aware, the students in our 
class work in teams as they design, produce, and present their 
projects. The students have been very good about waiting for 
this year’s teams to be announced, and I am happy to provide 
you with that breakdown. 
 
TEAM 1 
Kevin Smith 
Tim Jackson 
 
 
TEAM 2 
Leslie Brown 
Cindi Stuckey 
 
TEAM 3 
Neil Thornton 
Steven Harding 
 
Your student should make contact with his or her partner to 
select a topic for their project and start brainstorming some 
initial ideas. I will be sending more information home soon, but 
wanted to get this information out as quickly as possible. I look 
forward to seeing you soon! 
 
 
[Your Name] 
 
Washington Elementary School 

   Step 2: Creating the Mail Merge Database Table 
Use the information listed below for the following three students 
to create a database table for the form letters. Save the file as 
Address Database Table_z#.doc. Remember z# = your Z-
number. Save this document to your disk.  
 
You may cut and paste the text that is provided below.  
 

Student’s Name: Kevin Smith 
Parent: Mr. Glen Smith 
Address: 412 Main Street 
City: Geneva 
State: IL 
Zip: 60134 
 
 
Student's Name: Leslie Brown 
Parent: Ms. Alicia Brown 

3
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Street: 12 Seaside Lane 
City: St. Charles 
State: IL 
Zip: 60134 
 
 
Student's Name: Tim Jackson 
Parent: Mrs. Anita Jackson 
Street: 45 Parkside Avenue 
City: River Grove 
State: IL 
Zip: 60171 
 
 

   Step 3: Modifying the main document to make it 
compatible with the data source. 
Modify the main document to make it compatible with the data 
source by replacing text with merge fields. 
 
Parent 
Address 
City 
State  
Zip 
 

4 Modify  Manage  Copy Remove

   Step 4: Creating the Form Letters 
You will create two form letters for the first two students listed in 
your database table. Follow the directions outlined below: 

1. Open the form letter team_announce_z#.doc that you 
created.  

2. Using the Address Database Table_z#.doc document 
as your data source, create two form letters.  

3. Save the merged letters in a separate file using the file 
name merged_letters_z#.doc.  

4. Save the file to your disk.  

5 Modify  Manage  Copy Remove
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Preview Assessment: PowerPoint Concepts 

 ETRA SKILLS COMPETENCY EXAM > CONTROL PANEL > COMPETENCY EXAM > EXAM PART 3. MICROSOFT POWERPOINT > PREVIEW ASSESSMENT: 
POWERPOINT CONCEPTS

Name PowerPoint Concepts 

Instructions Please select the option(s) that best answer the questions. If a question contains more than 
one correct answer, select all of the answers that apply. When finished use the "Submit" 
button. Do not select "Save." 

Multiple Attempts Not allowed. This Test can only be taken once. 

Force Completion This Test must be completed now. 

 Question Completion Status: 

   Question 1 1 points   Save

 

Adding sounds to all slides at once can only be accomplished using the Slide 
Transition option in the Slide Show menu. 
 

 True

 False

   Question 2 1 points   Save

 

The footer options allow for the title slide footer to be different from the footers in the 
rest of the presentation. 
 

 True

 False

   Question 3 1 points   Save

 

Aligning objects on a slide can be accomplished by: 
 

 Putting them edge-to-edge. The objects will attach to one another 
automatically, one after the next. 

 Using the Link Objects option in the Format menu after clicking and dragging 
with the left mouse button to select all of the objects. 

 Using one of the selections (for example, Align Top) from the Align or Distribute 
option in the Draw menu. 

 Using the Lock option in the Tools menu, then dragging the objects into 
alignment. 

   Question 4 1 points   Save

 

The Background option in the Format menu can be used to insert which of the 
following into the background of slides? 
 

 Color gradients 

 Textures 

 Pictures 

Any of the above 
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   Question 5 1 points   Save

 

Using the Custom Shows option in the Slide Show menu controls: 
 

 The selection of certain sets of slides out of the entire presentation file to be 
shown as a unique presentation. 

 The use of different audio files in the playback of your presentation. 

 Settings that help when displaying the presentation on different types of 
equipment at various times. 

 The Master Slide settings for each slide in the presentation. 
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 PowerPoint Application Section  

 

  

 ETRA SKILLS COMPETENCY EXAM > CONTROL PANEL > COMPETENCY EXAM > EXAM PART 3. MICROSOFT POWERPOINT > POWERPOINT 
APPLICATION SECTION

  Item   Folder   External Link  Course Link  Test  Select:   Learning Unit

   Exercise Requirements - Microsoft PowerPoint 
nuclear_energy (53.818 Kb)  
nuclear.GIF (5.174 Kb)  
volcano.GIF (5.145 Kb)  
volcano (5.992 Kb)  

The science fair for your seventh grade class is coming up 
quickly! The students have been assigned a room where they 
will display their projects, and you decide to provide a number 
of ways for parents and guests to find the projects of interest to 
them. Part of that effort is the construction of a PowerPoint 
presentation that will act as a directory on a computer in the 
hallway. Use the specifications provided below to create the first 
three slides of this presentation. 

1. Open a new presentation.  
2. Apply a design of your choice.  
3. Add one title (welcome) slide.  
4. The title font should be changed on both the Slide 

Master and Title Master to Comic Sans.  
5. Add two directory slides for the two teams listed below.  
6. In each of the slides, place the team number in the title 

box of the slide and place the team information in the 
body of the slide with no bullets. 

TEAM 1  
Room 201  
Volcanoes  
Kevin Smith  
Tim Jackson  

TEAM 2  
Room 202  
Nuclear Energy  
Leslie Brown  
Cyndi Stuckey  

7. Add the relevant graphic images (volcano.GIF and 
nuclear.GIF) to the two directory slides. Graphic files can 
be downloaded from the list above.  

8. The presentation should include slide transitions 
between all slides.  

9. The presentation should include animation or build on all 
slides.  

10. Add a hyperlink that links the last slide of the 
presentation to the title slide.  

11. Save the presentation as ScienceFair_z#.ppt to your 
disk.  

1 Modify  Manage  Copy Remove
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Preview Assessment: Spreadsheet Concepts 

 ETRA SKILLS COMPETENCY EXAM > CONTROL PANEL > COMPETENCY EXAM > EXAM PART 4. MICROSOFT EXCEL > PREVIEW ASSESSMENT: 
SPREADSHEET CONCEPTS

Name Spreadsheet Concepts 

Instructions Please select the option(s) that best answer the questions. If a question contains more than 
one correct answer, select all of the answers that apply. When finished use the "Submit" 
button. Do not select "Save". 

Multiple Attempts Not allowed. This Test can only be taken once. 

Force Completion This Test must be completed now. 

 Question Completion Status: 

   Question 1 1 points   Save

 

Charts are automatically linked to the data from which they were created. 
 

 True

 False

   Question 2 1 points   Save

 

In Excel, the active cell has a heavy border around it. 
 

 True

 False

   Question 3 1 points   Save

 

Excel allows you to copy cell contents to adjacent cells by using the .... 
 

 Preview Handle 

 Fill Handle 

 Copy Handle 

 Move Handle 

   Question 4 1 points   Save

 

Which feature would you use to keep others from being able to modify cells in an 
Excel spreadsheet? 
 

 Protection> Protect Workbook

 Protection> Protect Sheet 

 Properties> Read Only 

 Window> Freeze Panes 

   Question 5 1 points   Save

Which feature would you use to hold the top row in place while scrolling through a 
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very long spreadsheet? 
 

 Arrange 

 Freeze Panes 

 Control + Home 

 Text to Columns 
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 Application Section  

 

  

 ETRA SKILLS COMPETENCY EXAM > CONTROL PANEL > COMPETENCY EXAM > EXAM PART 4. MICROSOFT EXCEL > APPLICATION SECTION

  Item   Folder   External Link  Course Link  Test  Select:   Learning Unit

   Exercise Requirements - Microsoft Excel 
student_grades.xls (13.5 Kb)  

The science fair for your seventh grade class has concluded, 
and you have assigned grades to the projects for the students 
in the class. Edit your science class grade sheet with the 
following specifications.  

First, download the Excel file student_grades.xls from the link 
above. After clickng on the link, use the Save option rather than 
the Open option in order to work in Excel with this file.  

1. Set Row 1 as a merged, centered cell with "Seventh 
Grade Science – 1st Period" as the heading. The text 
should be 14-point and boldfaced.  

2. Row 2 should consist of a merged, centered cell with 
your name as the only contents. The text should be 14-
point normal type. Turn on the bottom border of the 
merged cell with a solid line of the default width.  

3. Row 3 should be blank.  
4. Edit Row 4 so that the column header text is centered in 

the cells and appears as bold. Wrap the text in the cells.  
5. Align the text in columns c through k as centered.  
6. In column J, create a formula for each student to total 

their points.  
7. Assuming each Quiz was worth 10 points, and that each 

test and the final science project were worth 100, 
construct a formula for the cells in column k that will 
automatically calculate the term grade for each student. 
The final grade should be a whole number - no decimal 
places.  

8. Shade the Term Grade column (with any shading you 
feel is appropriate that allows the text to remain very 
readable.)  

9. Insert your name and the file date into the footer of the 
document.  

10. Save the file to your disk as student_grades_z#.xls.  

1 Modify  Manage  Copy Remove
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Preview Assessment: Internet Concepts 

 

   
    

 ETRA SKILLS COMPETENCY EXAM > CONTROL PANEL > COMPETENCY EXAM > EXAM PART 5. INTERNET AND WEB DEVELOPMENT SKILLS > 
PREVIEW ASSESSMENT: INTERNET CONCEPTS

Name Internet Concepts 

Instructions Please select the option(s) that best match the terms and phrases in the questions column. 
When finished use the "Submit" button. Do not select "Save." 

Multiple Attempts Not allowed. This Test can only be taken once. 

Force Completion This Test must be completed now. 

 Question Completion Status: 

   Question 1 10 points   Save

 

Please match the item from the Questions column with the best match from the 
Answer Column. 
 

 - Browser  

 - "middle grades science" and 
"lesson plans"  

 - .gov, .com, .edu  

 - URL  

 - http  

 - FTP  

 - Search Engine  

 - HTML  

 - ISP  

 - name@isp.domain  

 
A. Web address 
B. Internet Service Provider 
C. Uniform Resource Locator 
D. Boolean Search Strategy 
E. Internet Explorer 
F. Universal Reform Language 
G. File Transfer Protocol 
H. Hypertext Toggling Procedure 
I. Internet Domains 
J. Hypertext Markup Language 
K. Email address 
L. Internet Support Protocol 
M. Hop to More Links 
N. Files to Post 
O. Hypertext Transfer Protocol 
P. Google 
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 Web Page Development Application  

 

  

 ETRA SKILLS COMPETENCY EXAM > CONTROL PANEL > COMPETENCY EXAM > EXAM PART 5. INTERNET AND WEB DEVELOPMENT SKILLS > WEB 
PAGE DEVELOPMENT APPLICATION

  Item   Folder   External Link  Course Link  Test  Select:   Learning Unit

   Web Page Creation 
apple_books.gif (4.124 Kb)  
This application involves creation of a simple two-page web site 
for your classroom. You may create these two linked pages 
using any software available on the computer (e.g. 
Dreamweaver Mozilla Composer, MS Word, NotePad, etc.) 

Follow these steps as you create the web site:  

1. Create a blank main page and save it as home_z#.html.  
2. Type the title as  

[Your Name] Classroom Web Site  
3. Enlarge the font. Bold and center it on the page.  
4. Copy and paste the following text as the introduction to 

your website. The text should be centered under the 
title. 

This website is available for students and families to 
extend our classroom activities. Access to resources 
and homework help are also available. I hope you find 
what I have prepared helpful. I look forward to a 
rewarding and successful school year.  

5. Insert the graphic titled apple_books.gif (listed above). It 
should be centered under the Introduction. Image file is 
available above for downloading.  

6. Create a hyperlink to the resources_z# page (to be 
created).  

7. At the very bottom of the page, insert your contact 
information and provide a live link to your email address.  

8. Create a blank second page and save it is 
resources_z#.html.  

9. At the top of the Resources page, type the word 
Resources and underline.  

10. Beneath the word Resources, create the following 
bulleted list with live hyperlinks to these active websites. 
o Google – www.google.com  
o Puzzlemaker – www.puzzlemaker.com  
o Disney’s Family Site – www.family.com  

11. Create a link back to the home_z#.html page.  
12. Save both pages (i.e., Home_z#.html and 

Resources_z#.html) to your disk,. It is also necessary for 
you to submit the graphics file. 
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ETRA COMPUTER COMPTENCY EXAM 
Scoring Sheet 

 
 
Examinee’s Name  _________________________________________  Exam Date____________ 
 
Z # ______________________________________________________   
 

Exam Part Score 
Basic Computing Concepts (10 points)  

of 13 
Word processing Concepts (5 points)  

 
Word Processing Application (20 points) 

Step 1 and Step 3 (15 points) 
Margins 1”    ________ 
Font type 12    ________ 
Font Size TNR    ________ 
Single Paragraph Spacing  ________ 
Today’s Date    ________ 
Header     ________ 
Header font   (Arial)  ________ 
Header size    (16pt)  ________ 
Header/Footer Margin (0.5”) ________ 
Header Placement   ________ 
2x3 Table    ________ 
Centered Table    ________ 
Text Placement    ________ 
Bold Text    (upper cells)  ________ 
6 Merge Fields Entered  ________ 

 
Step 2 (3 points) 

Database Table Created  ________ 
Six Fields for each entry  ________ 
Data Table Submitted  ________ 

 
Step 4 (2 points) 

Merge Successful   ________ 
2 Letters  submitted  ________ 

 

 
 
 

Word Section Total  
of 25 

PowerPoint Concepts (5 points)  
PowerPoint Application (20 points) 

New Presentation   ________ 
Apply design   ________ 
Welcome Slide   ________ 
Title font in Comic Sans  ________ 
Slide Master Font in Comic Sans ________ 
Directory Slide Team 1 (2 pts) ________* 
Directory Slide Team 2 (2 pts) ________* 
Text Placement   ________ 
No bullets   ________ 
Images added   ________ 
Transitions (2 pts)  ________* 
Animation or Build (2 pts)  ________* 
Hyperlink added (2 pts)  ________* 
Presentation Saved  ________ 
Presentation Submitted  ________ 
 

 
 

PowerPoint Section Total  
of 25 

 



ETRA COMPUTER COMPTENCY EXAM 
Scoring Sheet 

 
 

Internet Concepts (10 points)  
 

 
Web Page Development (20 points) 

Main page created   ________ 
Title added    ________ 
Title enlarged, bold and centered  ________ 
Introductory paragraph inserted  ________ 
Introductory paragraph centered  ________ 
Graphic placed    ________

 Graphic centered    ________ 
Resources link    ________ 
Contact information   ________ 
Mailto Link (2 pts)    ________* 
Resources page created   ________ 
Title inserted     ________ 
Title text underlined   ________ 
Bulleted list (2 pts)    ________* 
Links active (2 pts)    ________* 
Home Link    ________ 
Saved and submitted    ________ 

 

 
 

Internet Section Total: of 30 
Excel Concepts (5 points)  

 
Excel Application (20 points) 
 

Download File    ________ 
Rows 1 and 2 merged, centered (2 pts) ________* 
Row 1 text 14 pt bold   ________ 
Row 2 text 14 pt    ________ 
Row 2 bottom border   ________ 
Row 4 column headers bold  ________ 
Row 4 column Headers centered  ________ 
Row 4 text wrapped   ________ 
Column text aligned center  (C-J)  ________ 
Total points formula (2 pts)  ________* 
Term average formula (3 pts)  ________** 
Numbers presented as whole  ________ 
Term Grade column shade   ________ 
Footer (2 pts)    ________* 
Saved and Submitted   ________ 
 

 
 

Excel Section of 25 
Exam Total of 118 

 
Comments: 
 
 
 
Scorer’s Recommendation: 
 
____________ Waiver of ETT 229     ____________ Enrollment in ETT 229 
 
 
Scorer: _________________________________  Date___________________________ 
 




